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CURIOSITY LOW PIN COUNT DEVELOPMENT
BOARD USER’S GUIDE
Preface
INTRODUCTION

This chapter contains general information that will be useful to know before using the 
Curiosity LPC Development Board. Items discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• Recommended Reading

• The Microchip Website

• Development Systems Customer Change Notification Service

• Customer Support

• Revision History

DOCUMENT LAYOUT

This document describes how to use the Curiosity LPC Development Board as a 
development tool to emulate and debug firmware on a target board. The document is 
organized as follows:
• Chapter 1. “Introduction to Curiosity Low Pin Count (LPC)” – This chapter 

contains general information regarding the Curiosity LPC Development Board kit 
contents, layout and power source.

• Chapter 2. “Getting Started” – This chapter offers information on how to 
program the Curiosity LPC Development Board.

• Chapter 3. “Troubleshooting” – Consult this chapter for troubleshooting 
information.

• Appendix A. “Schematic” – This appendix lists the Curiosity LPC Development 
Board schematic.

• Appendix B. “General Notes” – Refer to this appendix for general notes on 
using the Click module sockets and the solder blob jumpers.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2015-2020 Microchip Technology Inc. DS40001804D-page 4



Curiosity Low Pin Count Development Board User’s Guide
CONVENTIONS USED IN THIS GUIDE 

This manual uses the following documentation conventions:

DOCUMENT CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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Preface
RECOMMENDED READING

This user’s guide describes how to use the Curiosity LPC Development Board. For the 
latest information on using other tools, refer to the MPLAB® X IDE home page: 
www.microchip.com/mplab/mplab-x-ide. This resource page contains updated 
documentation, downloads and links to other MPLAB X compatible tools, plug-ins and 
much more.

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website 
is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the website contains the following 
information:

• Product Support – Data sheets and errata, application notes, sample programs 
and labs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software
Curiosity Development Board-specific product support can be accessed via our 
website at www.microchip.com/promo/curiosity-development-boards.

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip website at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers, assemblers, linkers 
and other language tools. These include all MPLAB C compilers; all MPLAB 
assemblers (including MPASM™ assembler); all MPLAB linkers (including 
MPLINK™ object linker); and all MPLAB librarians (including MPLIB™ object 
librarian).

• Emulators – The latest information on Microchip in-circuit emulators.This 
includes the MPLAB REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit™ 3 
debug express.

• MPLAB IDE – The latest information on Microchip MPLAB IDE, the Windows® 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART® Plus and 
PICkit 2 and 3.
 2015-2020 Microchip Technology Inc. DS40001804D-page 6
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Curiosity Low Pin Count Development Board User’s Guide
CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers.

Technical support is available through the website at: 

www.microchip.com/support.

REVISION HISTORY

Revision D (March 2020)

Added new layout revision and content updates.

Revision C (September 2019)

Updated Figures 2-1 through 2-4 and A-1.

Remove EU Declaration of Conformity.

Revision B (April 2016)

Added the EU Declaration of Conformity.

Revision A (July 2015)

Initial release of this document.
DS40001804D-page 7  2015-2020 Microchip Technology Inc.

http://www.microchip.com/support/hottopics.aspx
http://www.microchip.com/support/hottopics.aspx
http://www.microchip.com/support/hottopics.aspx


CURIOSITY LOW PIN COUNT DEVELOPMENT
BOARD USER’S GUIDE
Chapter 1.  Introduction to Curiosity Low Pin Count (LPC) 
The Curiosity Low Pin Count (LPC) Development Board supports Microchip’s 8-, 14- 
and 20-pin 8-bit PIC® MCUs. Dual-row expansion headers on either side of the socket 
offer flexibility of connectivity to all pins on the PIC MCUs. Programming/debugging is 
accomplished through the PICkit™ On-Board (PKOB), eliminating the need for an 
external programming/debugging tool. This board provides flexibility for 
experimentation through an application header with a ground (GND) and supply 
voltage (VSS) connections. It is also a set of indication LEDs, mTouch® button and push 
button switches, and a variable potentiometer. Additionally, the Curiosity LPC Board 
integrates a MikroElektronika mikroBUS™ socket, which can accommodate a variety 
of plug-in Click™ Board modules that can be used for application development.

1.1 CURIOSITY LOW PIN COUNT (LPC) DEVELOPMENT BOARD KIT 
CONTENTS

The Curiosity Low Pin Count (LPC) Development Board kit contains the following: 

• Curiosity Low Pin Count (LPC) Development Board 

• Quick Start Guide

• PIC16F18446 MCU

FIGURE 1-1: CURIOSITY LOW PIN COUNT (LPC) DEVELOPMENT BOARD 
REV 2

mTouch®
Button

™
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FIGURE 1-2: CURIOSITY LOW PIN COUNT (LPC) DEVELOPMENT BOARD 
REV 4
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CURIOSITY LOW PIN COUNT DEVELOPMENT
BOARD USER’S GUIDE
Chapter 2.  Getting Started
The Curiosity Low Pin Count (LPC) Development Board contains a PICkit On-Board 
(PKOB) which allows for both low-voltage programming and low-voltage in-circuit 
debugging for all supported devices. When used with the MPLAB IDE, in-circuit 
debugging allows the user to run, modify, and troubleshoot their custom software and 
hardware quickly, without the need for additional debugging tools.

2.1 PROGRAMMING THE CURIOSITY LOW PIN COUNT (LPC) DEVELOPMENT 
BOARD

Programming the Curiosity LPC Development Board can be accomplished through 
MPLAB X IDE (version 3.30 or higher for Rev 2 and version 5.20 or higher for Rev 4). 

2.1.1 Programming Using MPLAB® X IDE

1. Connect the Curiosity LPC Board to the computer using the on-board micro-USB 
connector.

2. Open MPLAB X IDE and either create a new project or open an existing one.

3. Click on the Project Properties icon located in the project’s Dashboard window 
(as seen in Figure 2-1). Alternatively, the Project Properties window can be 
opened by clicking on File > Project Properties, or by right clicking on the project 
name in the Projects window and clicking Properties.

Note: The Curiosity LPC Board must be programmed using Low-Voltage 
Programming (LVP). The LVP bit of the Configuration Word(s) must be set 
(LVP = ON or ‘1’).
 2015-2020 Microchip Technology Inc. DS40001804D-page 10



FIGURE 2-1: PROJECT PROPERTIES BUTTON

4. The Project Properties window will open. This window allows for the selection of 
the programming tool, compiler and PIC MCU. MPLAB X IDE refers to the 
Curiosity LPC Board as “Starter Kits” in the Hardware Tool selection window, as 
seen in Figure 2-2.

FIGURE 2-2: SELECTING THE CURIOSITY LPC DEVELOPMENT BOARD 

5. In the upper left-hand corner of the Project Properties window, click on Starter 
Kits (PKOB). The window will now show the configuration options for the PKOB 
programmer, as shown in Figure 2-3.
 2015-2020 Microchip Technology Inc. DS40001804D-page 11



FIGURE 2-3: PROGRAM OPTIONS FOR THE PICkit™ ON-BOARD (PKOB)

6. In the Option categories drop-down menu, select Program Options; ensure that 
the Low Voltage Programming mode is selected for Programming mode entry 
(Figure 2-4). The Curiosity LPC Board is now ready to be programmed.

FIGURE 2-4: ENSURE LOW-VOLTAGE PROGRAMMING IS ENABLED
 2015-2020 Microchip Technology Inc. DS40001804D-page 12



7. Once the project is ready to be programmed, simply click on the Make and 
Program Device button, and MPLAB X IDE will build and compile the code and 
program the PIC device, as displayed in Figure 2-5.

FIGURE 2-5: DEVICE PROGRAMMING
 2015-2020 Microchip Technology Inc. DS40001804D-page 13



CURIOSITY LOW PIN COUNT DEVELOPMENT
BOARD USER’S GUIDE
Chapter 3.  Troubleshooting
This chapter discusses common operational issues and methods to resolve them.

3.1 THE MCU WILL NOT PROGRAM USING THE PKOB

The Curiosity LPC Development Board’s PICkit On-Board (PKOB) uses low-voltage 
programming. Both MPLAB X IDE and MPLAB Xpress set the Low-Voltage 
Programming (LVP) bit to a ‘1’, allowing low-voltage programming. 

1. When using custom firmware, the LVP bit must be set to ‘1’ in the Configuration 
Word. MPLAB X IDE will not allow programming using the PKOB unless the bit 
is properly configured.

2. When using a PIC microcontroller (one not included with the Curiosity 
Development Board) that has already been programmed using high-voltage 
programming and the LVP bit is cleared (LVP = OFF or ‘0’), the device will not be 
recognized and cannot be programmed using the PKOB. Reprogramming the 
device can be achieved by one of the following two methods:

a) Connect a PICkit™ 3 Programmer to the PIC device dual-row expansion 
headers, ensuring the appropriate ICSP™, GND, and VDD connections are 
made. Configure MPLAB IDE to use the PICkit 3 as the programmer, and 
ensure the LVP bit is set to ‘1’ in the Configuration Word. Reprogram the 
device.

b) Use an unprogrammed (blank) device and ensure the LVP bit is set to ‘1’ in 
the Configuration Word.

3.2 THE MPLAB PICKIT™ 4 ON-BOARD (PKOB4) DOES NOT PERFORM

Use the Hardware Tool Emergency Boot Firmware Recovery Utility to restore hard-
ware tool boot firmware to its factory state. The recovery utility window can be opened 
by clicking on Debug > Hardware Tool Emergency Boot Firmware Recovery Utility in 
MPLAB X IDE.The Curiosity LPC Development Board’s PICkit On-Board (PKOB) uses 
low-voltage programming. Both MPLAB X IDE and MPLAB Xpress sets the Low-Volt-
age Programming (LVP) bit to a ‘1’, allowing low-voltage programming. 
 2015-2020 Microchip Technology Inc. DS40001804D-page 14



CURIOSITY LOW PIN COUNT DEVELOPMENT
BOARD USER’S GUIDE
Appendix A. Schematic
A.1 CURIOSITY LPC DEVELOPMENT BOARD SCHEMATICS

FIGURE A-1: CURIOSITY LPC DEVELOPMENT BOARD SCHEMATIC REV 2 (1 OF 1)

1

1

2

2

3

3

4

4

5

5

6

6

D D

C C

B B

A A

1 of 1

Curiosity

8/8/2018 9:11:25 AM

03-10327 sheet 1.SchDoc

Project Title

Sch #: Date:

File:
Revision: Sheet

Designed with

Drawn By:
Jamus Griego

Sheet Title

**

Engineer:
John Mouton

03-10327
2.2

Size
B

10327
PartNumber:

Altium.com

TACT SPST

S2

TACT SPST

S1

RED
D4

HDR-2.54 Female 2x10

1 2

3 4

5 6

7 8

9 1
0

1
1

1
2

1
3

1
4

1
5

1
6

1
7

1
8

1
9

2
0

J11

1k
R40

1k
R41

10k
R38

10k
R29

470R

R39

470R

R31

VDD

VDD

GND GND GND GND

GND

GND

GND

VDD

HDR-2.54 Male 2x4

11
2

3
4

5
6

7
8

J13

PJ-002BH-SMT

2
3
1J15

0.1uF
25V

C16

GND

LM340MP-5.0

GND

2

VIN
1

VOUT
3

U5
US1M

D3

0.22uF
C17

GND

VDD

RB5

HDR-2.54 Male 1x2

1 2

J4

TP2

TP1

GREEN
D2

470R
R35

GND

VDD

HDR-2.54 Female 2x10

1 2

3 4

5 6

7 8

9 1
0

1
1

1
2

1
3

1
4

1
5

1
6

1
7

1
8

1
9

2
0

J9

HDR-2.54 Male 1x2

1
2

J3

470R

R32

110-91-320-41-001

4
5
6
7
8
9

10

16
15
14
13
12
11

17

1
2
3

19
18

20

U4

0.1uF
25V

C15

RED
D5

RED
D6

RED
D7

PGED
PGEC

1k
R42

1k
R43

HDR-2.54 Male 1X6 STAGGERD

1
2
3
4
5
6

P1

HDR-2.54 Male 1x3

123

J12

mikroBUS

AN
1

AN
RST

2

CS
3

SCK
4

MISO
5

MOSI
6

+3.3V
7

GND
8

PWM
16

INT
15

RX
14

TX
13

SCL
12

SDA
11

+5V
10

GND
9

J35

H
D

R
-2

.5
4

F
em

al
e

1
x

8

1
2
3
4
5
6
7
8

J34

H
D

R
-2

.5
4

F
em

al
e

1
x

8

1
2
3
4
5
6
7
8

J33

0R
0402

R33

mTouch
S3

HDR-2.54 Male 1x2

12

J5

0R
0402

R44

10k

R37 RC0
RC1

GND

0R

R46

0R
0402

R34

+5V

+5V

POWER

0
R R
47

0
R

R
48

0
R

R
49

0
R

R
50

RC7 RC7
RB7 RB7

RC3
RC4
RC5

RC6

RA4
RA5

nMCLR

RC3
RC4
RC5

RC6

RA4
RA5

nMCLR

VDD

RC0
RC1
RC2
RB4
RB5
RB6

RB4
RB5
RB6

RC0
RC1
RC2

RA2 RA2

PGED
PGEC

PGED
PGEC

RC4

nMCLR

PGEC
PGED

ICSP_VDD

ICSP_VDD
nMCLR

HDR-2.54 Male 1x2

1 2

J6

VDD

R
A

5

P
G

E
C

R
A

2

R
C

5

VDD

GND

GND

0R R51

0R R53
0R R55

0R R57
RB4

RC6

RB6
RC7

1 2

3 4

5 6

7 8

HDR-2.54 Male 2x4J39

SCK

SCK

MISO

MISO

MOSI

MOSI

CS

CS

SCK
MISO

MOSI
CS

RB4

RC6

RB6
RC7

0RR52

0RR54

0RR56
0RR58 RB6

RB4

RB5

RB7

12

34

56

78

HDR-2.54 Male 2x4
J40

RX

TX

SCL
SDA

RB6
RB4

RB5

RB7

RX

TX

SCL
SDA

RX
TX

SCL
SDA

DNP DNP

DNP

DNP

DNP

DNP

VDD

D_VBUS +5V

VCMP

GND

MCP6561

+A
3

-A
4

OUTA
1

VSS

2

VDD

5

+A

-A

OUTA
VSS

VDD

A

A

A

A

A
S

D

U16
VREF_2.5V

TP4

TP3

10k
R61

RC2
RA4

RC5
RA2

+5V+3.3V

GND GND

2k
0603

R59

VCMP

+9V

+5V

+3.3V

10k

2
1

3

POT1

GND
1

AIO2
2

AIO1
3

AIO0
4

UART_TX
5

UART_RX
6

WAKE_SW
7

CMD/MLDP
8

GND
9

LED/PIO1/SCK
10

MLDP_EV/PIO2/CS
11

WS/PIO3/MOSI
12

PIO4/MISO
13

CTS/PIO5
14

WAKE_HW
15

GND
16

SPI/PIO
17

RTS/PIO6
18

PIO7
19

RSVD
20

RSVD
21

RSVD
22

VDD
23

GND
24

GND

AIO2
AIO1
AIO0

UART_TX
UART_RX

WAKE_SW

CMD/MLDP

GND

LED/PIO1/SCK
MLDP_EV/PIO2/CS

WS/PIO3/MOSI
PIO4/MISO

CTS/PIO5

WAKE_HW
GND

SPI/PIO

RTS/PIO6

PIO7

RSVD
RSVD
RSVD

VDD

GND

RN4020

U6+3.3V

GND

RX
TX

4.7uF
C18

RC0

DNP
DNP

DNP

DNP

DNP

0R
0603

R45
DNP

DNP

DNP

DNP

DNP

VIN

HDR-2.54 Female 1x6

1 2 3 4 5 6

J7DNP

VIN

GND

+3.3V

+5V

Button

TM

1k
R26

1uF
16V

C11
GND

2

VIN
1

VOUT
3

MCP1703-3302E/DB

Q2

10k
R27

0.01uF
16V

C14

+3.3V

POWER_GOOD_PICKIT3
GREEN
D1

0.1uF
25V

C13
0.22uF
16V

C10
1uF
16V

C12

+5V

+3.3V

USB_D_P
USB_D_N

VBUS054B-HS3-GS08

1 2 3
56

V

4

U3

500mA

+t

1210

PTC3

D_VBUS

USB MINI-B Female

ID
4

VBUS
1

GND
5

D-
2

D+
3

0

J2

U
S

B
IN

T
E

R
F

A
C

E

(B
U

S
P

O
W

E
R

E
D

)

X1 X2 X3 X4 X5

DNP

2
1

3

PIC16F18346-I/P

RA3/Vpp/MCLR
4

RC5
5

RC4
6

RC3
7

RC6
8

RC7
9

RB7
10

RB6
11

RB5
12

RB4
13

RC2
14

RC1
15

RC0
16

RA2
17

RA1/ICSPCLK
18

RA0/ICSPDAT
19

VSS
20

VDD
1

RA5/OSC1
2

RA4/OSC2
3

@U4

10k
R60

GND

1
2

3
4

5
6

7
8

HDR-2.54 Male 1x8

J8

1 2 3 4 5 6 7 8

HDR-2.54 Male 1x8
J14

1
2

3
4

5
6

7
8

HDR-2.54 Male 1x8

J10

GND

RX
TX

R
C

0

GND GND

AIO0
AIO1
AIO2

AIO0
AIO1
AIO2

WAKE_SW

WAKE_SW

CMD/MLDP

CMD/MLDP

LED/PIO1/SCK

L
E

D
/P

IO
1
/S

C
K

W
S

/P
IO

3
/M

O
S

I

WS/PIO3/MOSI
MLDP_EV/PIO2/CS

M
L

D
P

_
E

V
/P

IO
2
/C

S

P
IO

4
/M

IS
O

PIO4/MISO

CTS/PIO5

C
T

S
/P

IO
5

SPI/PIO

SPI/PIO

RTS/PIO6

RTS/PIO6

PIO7

PIO7

RSVD0
RSVD1
RSVD2

RSVD0
RSVD1
RSVD2
+3.3V

DNP DNP

DNP

FDN340P

2

1

3

Q5

REV ECO# DESCRIPTION DATE

2
Move Silkscreen of R14 so it can be read. Swap RB4 and

RC7 connections. Change @U4 to PIC16F1619-I/P

3-31-2015

DNP

Phillips Screw 1/4"

SCR1

Phillips Screw 1/4"

SCR2

Phillips Screw 1/4"

SCR3

Phillips Screw 1/4"

SCR4

2.2 8-2-2018Change @U4 to PIC16F18346-I/P

1/4" Standoff Nylon

STANDOFF1

1/4" Standoff Nylon

STANDOFF2

1/4" Standoff Nylon

STANDOFF3

1/4" Standoff Nylon

STANDOFF4
 2015-2020 Microchip Technology Inc. DS40001804D-page 15



Schematic
FIGURE A-2: CURIOSITY LPC DEVELOPMENT BOARD SCHEMATIC REV 4 (1 OF 4)
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Schematic
FIGURE A-3: CURIOSITY LPC DEVELOPMENT BOARD SCHEMATIC REV 4 (2 OF 4)
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Schematic
FIGURE A-4: CURIOSITY LPC DEVELOPMENT BOARD SCHEMATIC REV 4 (3 OF 4)

Curiosity LPC
Designed with

R62

R63

R64

CLK_EN

DATA_EN

C29

C28

R65

R69

R68

ICSP

ICSP
ICSP_SPI0_SPCK

ICSP_SPI0_MOSI
ICSP_SPI0_MISO

ISP_SPI1_SPCK

ICSP_SPI0_MOSI

ICSP_SPI0_MISO

ICSP_SPI0_SPCK (ICSP_SCK)

(SCK_IN)

(ICSP_SDO)

(ICSP_SDI)

ICSP

ISP_SPI1_SPCK

R66

R67

Q2

VPP_ON

VPP_GND

VPP Switch

R30

R27

R26

Q3

Q4

C26 C27

DATA_EN
CLK_EN

R28

R36

R46

MCLR

PGD

PGC

Curiosity LPC
Designed with

Virtual Comm Port

C21

R70

C22

R71

VCP
VCOM

(From Target TX)
(To Target RX)
 2015-2020 Microchip Technology Inc. DS40001804D-page 18



Schematic
FIGURE A-5: CURIOSITY LPC DEVELOPMENT BOARD SCHEMATIC REV 4 (4 OF 4)
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CURIOSITY LOW PIN COUNT DEVELOPMENT
BOARD USER’S GUIDE
Appendix B. General Notes
B.1 mikroBUS™ CLICKS

Module 1 is the main click socket, and Module 2 is the secondary socket. Both sockets 
are fully compatible with a 40-pin PIC device; however, when using 28-pin devices, not 
all pins are available. 

All pins in Module 1 are available for use with the exception of the mikroBUS's Reset 
(RST) signal, which is tied to pin RD0. PORT D is not available on 28-pin devices. If 
the RST signal is needed, remove the solder blob jumper associated with the 
mikroBUS RST connection, and place a jumper wire between the via next to the solder 
blob jumper and the desired pin connection found in the J8 or J11 dual-row expansion 
headers (see Figure 1-1).

All pins in Module 2 are available for use with the exception of the mikroBUS's Reset 
(RST) signal (RD2), SPI Chip Select (CS) signal (RD3), and the PWM (RD1) signal. 
These signals are routed to the PORT D pins, which are not available on 28-pin PIC 
devices. If these signals are needed, remove the solder blob jumpers associated with 
the mikroBUS connection pins, and place jumper wires from the vias located next to 
the associated solder blob jumpers to the desired pin connections found in the J8 or 
J11 dual-row expansion headers (see Figure 1-1).

B.2 SOLDER BLOB JUMPER

Solder blob jumpers can be found on each Click module, push-button switch, LED, or 
potentiometer connection. This allows the user to utilize those pin connections for other 
applications.
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